Contents

1. Welcome ......................................................................................................................................................... 4
   1.1 Copyright Notice .......................................................................................................................................... 4
   1.2 Benefits ...................................................................................................................................................... 5
   1.3 Studio Visualizer for Labels ......................................................................................................................... 7
   1.4 Feature Comparison .................................................................................................................................... 8
   1.5 What’s New in Studio Visualizer 12 ............................................................................................................ 12

2. Core Concepts ................................................................................................................................................ 13
   2.1 Exploring the Workspace ............................................................................................................................ 13
   2.2 Toolbar Button Reference ........................................................................................................................... 16
   2.3 Environments and Backdrops ..................................................................................................................... 19

3. Build a Model from a PDF ............................................................................................................................. 21
   3.1 Prepare the PDF .......................................................................................................................................... 21
   3.2 Load or Import the PDF .............................................................................................................................. 22
      3.2.1 Autobuild Options in Detail .................................................................................................................. 23
   3.3 Move, Rotate, Zoom and Pan the View Window ........................................................................................ 25
   3.4 Tweaking and Folding .................................................................................................................................. 25

4. Build a Model From Scratch ........................................................................................................................ 27
   4.1 Create a New Model .................................................................................................................................... 27
   4.2 Set the Substrate Material ........................................................................................................................... 29
   4.3 Fold the Model ............................................................................................................................................ 31
   4.4 Add Process Colors ..................................................................................................................................... 40
   4.5 Add Spot Colors ........................................................................................................................................ 41
   4.6 Add Special Finishes .................................................................................................................................... 42
   4.7 Build a Model From a Structural Design File .............................................................................................. 43

5. Viewing your Model ......................................................................................................................................... 45
   5.1 Studio Visualizer in View Mode ................................................................................................................... 45
   5.2 Move, Rotate, Zoom and Pan the View Window .......................................................................................... 45
   5.3 Setting the Scene .......................................................................................................................................... 46
      5.3.1 Setting the environment ......................................................................................................................... 46
      5.3.2 Using a backdrop ................................................................................................................................... 46
      5.3.3 Standing model versus Floating model ............................................................................................... 46

6. Communicating Your Designs ........................................................................................................................ 49
   6.1 Creating Movies of Your Models ................................................................................................................ 49
      6.1.1 Movie Types ......................................................................................................................................... 49
      6.1.2 Save a Movie ....................................................................................................................................... 49
      6.1.3 Save a Movie Preset ............................................................................................................................. 51
6.1.4 Output Format Options ........................................................................................................... 53
6.1.5 Movie Size Options .................................................................................................................. 54
6.1.6 Interactive Movies in Detail .................................................................................................... 55
6.1.7 Horizontal and Vertical Movies in Detail ................................................................................ 58
6.1.8 Gyration Movies in Detail ...................................................................................................... 59
6.2 Export 3D file ................................................................................................................................... 60
6.2.1 Exporting a 3D file for viewing ............................................................................................... 61
6.2.2 Setting up Collada Upload Sites ............................................................................................ 62

7. The Tools in Detail ............................................................................................................................ 65
7.1 The Operation Stack in Detail ..................................................................................................... 65
7.1.1 Add an Operation to the Stack ............................................................................................... 67
7.1.2 Edit an Operation in the Stack ................................................................................................ 68
7.1.3 Remove an Operation from the Stack ..................................................................................... 68
7.1.4 Move an Operation Up or Down ............................................................................................. 68
7.1.5 Reloading the Images for an Operation .................................................................................. 69
7.2 The Fold/Cylinder Settings Tool in Detail .................................................................................. 69
7.2.1 The Folded Box Tab ................................................................................................................ 70
7.2.2 The Cylinder Tab .................................................................................................................... 76
7.2.3 The Structural Design Tab ..................................................................................................... 80
7.3 The Operation Selector in Detail ................................................................................................. 84
7.3.1 The Color Picker .................................................................................................................... 86
7.3.2 The Operation Folder View .................................................................................................... 88
7.3.3 Operation Preview and Find Tool ........................................................................................... 90
7.3.4 User Operations Explained ..................................................................................................... 92
7.3.5 Create a User Operation ......................................................................................................... 94
7.4 The Substrate Selector in Detail ................................................................................................. 96
7.5 The Artwork Selector in Detail .................................................................................................. 98
7.5.1 Load and Manage Artwork ..................................................................................................... 100
7.5.2 Transformations and Filters for Artwork .............................................................................. 100
7.6 Editing non-printable materials ................................................................................................ 103
7.7 Shapes ........................................................................................................................................... 105

8. Customising the View with Presets ............................................................................................ 107
8.1 The View Presets Dialog ............................................................................................................. 107
8.2 Create a View Preset .................................................................................................................... 109
8.3 Restore the View with a Preset ..................................................................................................... 110
8.4 Delete a View Preset .................................................................................................................... 110
1. Welcome

Studio Visualizer is the market-leading print finish visualization system that lets you realistically view standard print, special inks and decorative finishes in 3D environments with true lighting conditions. You can rotate your print model through 360 degrees in any direction in to light or shade and see the reflections, demonstrating its appearance when printed.

If you’re new to Studio Visualizer, we recommend that you start by reading the topics in the Core Concepts section and then move on to looking at how to Build a model from a PDF or the step by step model creation tutorial to get up and running. Once you have learned the basics of model creation within Studio Visualizer, the remainder of the help system will provide the information you need to learn about some of the more advanced features of the software.

You will also find further information and news on Studio Visualizer at www.eskoartwork.com.

1.1 Copyright Notice

© Copyright 2012 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Esko Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of any kind. There are no warranties granted or extended by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or the information contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE®, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2012. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.
1.2 Benefits

Reduce the need for physical proofs

Produce realistic print models in just a few minutes. Get your designs out of the prototype stages quickly. Avoid unpleasant surprises when the print job comes back from the printer.
Reduce costs, shorten project cycles, please clients!

Interactively explore creative options at no cost

With Studio Visualizer, you are free to explore and experiment with otherwise expensive print processes and materials. Try materials and effects that you haven't been able to use before, all at the touch of a button.
For the first time ever you can design with effects that you know will work, rather than with those that might.
Design with confidence!
Communicate complex print design ideas and concepts

Pitch your design ideas to your clients and project managers, responding to their suggestions interactively. Win clients with the ability to present multiple prototype variations in contrast to each of your competitors’ single mock-ups.

Communicate your ideas electronically. With Studio Visualizer you can create interactive 3D illustrations of your design concepts, complete with special finishes, that may be put into an email or placed on a web site.

Use Studio Visualizer as a powerful marketing tool

Let others evaluate your designs by using the realistic visualization capabilities of Studio Visualizer. Reduce the need to create and ship a variety of mock-ups.

Generate pack-shots and images for use in catalogues, brochures and marketing literature, saving costs on professional illustration and photography. Create effective images and animations for use in electronic marketing and retailing.
1.3 Studio Visualizer for Labels

What is Studio Visualizer for Labels?

The Labels edition of Studio Visualizer brings the advanced print visualization technology of Studio Visualizer to users who do not need folding or CAD support.

Labels specialists, commercial printers and graphic designers can all benefit from the ability of Studio Visualizer for Labels to quickly preview complex print designs without having to make expensive mockups.

Tips and tricks: die-cut labels

Labels are very often die cut to add interest or to fit the package or product they will be applied to. The best way to model die-cut labels in Studio Visualizer and Studio Visualizer for Labels is to use masked substrate operations. You can find these in the masked labels folder inside the label materials section of the Operation Selector.

To use a masked substrate you need a mask image indicating the area covered by the label. Very often the label artwork will include die cut lines rather than a filled mask, so you first need to produce a solid-filled die cut mask: If the die cut is a vector object, this might be as simple as changing the fill color to black, otherwise you may need to use the Paint Bucket tool in Adobe Photoshop or a similar raster graphics application.

Once you have the label mask, proceed as follows:

1. Load the label artwork PDF in Studio Visualizer to create a new print model.
2. At the base of the operation stack change the paper substrate (glossy coated paper by default) to the base material of the package that the label will be applied to (e.g. glass or clear PET).
3. Above the new base material add a masked label operation from the masked labels folder inside the label materials section. When prompted for a mask image, select the die cut mask image that you created earlier.

You should now have a good representation of the appearance of the label on the package.

Tips and tricks: back-printing

It is possible to simulate the effects of back-printing on transparent labels using a few simple steps.

Take, for example, a back-printed transparent OPP label. This might be printed using a metallic spot color, some process color and an opaque white, all printed on the back side of the OPP film.

To simulate this in Studio Visualizer:

1. Apply the print artwork to the front of the sheet, but reverse the print order: opaque white first and metallic spot last.
2. Add another layer of OPP film using the transparent OPP film with mask operation.
3. If you don't have a mask for this and want to cover the whole surface, then click Finish and choose Don't use artwork if prompted.
### 1.4 Feature Comparison

Table: Feature comparison of Studio Visualizer and Studio Visualizer for Labels.

<table>
<thead>
<tr>
<th>Features</th>
<th>Studio Visualizer</th>
<th>Studio Visualizer for labels</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>rotate model, move viewpoint, pan and zoom</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>view Operation Stack showing print process sequence</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>view model in folded state</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>switch between flat sheet, die-cut sheet, and folded views</td>
<td>✓</td>
<td>flat+curved</td>
</tr>
<tr>
<td>make print or finishing operation invisible/visible</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>select viewing environment</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>use colored or user supplied image backdrop</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>dynamic field of view adjustment</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>save and restore view presets</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>change the array settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Features</td>
<td>Studio Visualizer</td>
<td>Studio Visualizer for labels</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>view array of models</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>load and view two print models simultaneously</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Materials and operations**

<table>
<thead>
<tr>
<th>Features</th>
<th>Studio Visualizer</th>
<th>Studio Visualizer for labels</th>
</tr>
</thead>
<tbody>
<tr>
<td>range of substrates</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>process, spot color, special inks (metallic and fluorescent)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>varnish, lamination, foil, single level emboss and deboss</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>PANTONE MATCHING SYSTEM® inks</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Eckart® metallic inks</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>MetalFX® metallic color system</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>label substrates - plain and metallized paper, PE and OPP films</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>advanced finishes - sculptured (3D) emboss, flitter, etc.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>die cutting</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Features</td>
<td>Studio Visualizer</td>
<td>Studio Visualizer for labels</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>holographic / diffraction foils</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Open, create and modify</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>auto-build print sequence from PDF file</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>select mask image to control print operation, in one of the following formats:</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>raster image formats: BMP, BW, GIF, JPEG, JPG, PCT, PNG, RGB, RGBA, SGI, TGA, TIF, TIFF</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Photoshop PSD: with selection of one or more layers or channels</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>vector file formats: PDF (on Mac and PC), Postscript and EPS (on Mac only)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>print on back of sheet as well as front</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>create legacy 6-face PVZ models</td>
<td>✓</td>
<td>X</td>
</tr>
<tr>
<td>open legacy 6-face PVZ models</td>
<td>✓</td>
<td>X</td>
</tr>
<tr>
<td><strong>Geometry</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>import and align structural design from ArtiosCAD ARD or Esko PDF file</td>
<td>✓</td>
<td>X</td>
</tr>
<tr>
<td>fold printed sheet using simple box fold tool</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Features

<table>
<thead>
<tr>
<th>Features</th>
<th>Studio Visualizer</th>
<th>Studio Visualizer for labels</th>
</tr>
</thead>
<tbody>
<tr>
<td>wrap into partial or full cylindrical shape</td>
<td>✓</td>
<td>✗</td>
</tr>
<tr>
<td>Import 3D model files from Collada archives (ZAE).</td>
<td>✓</td>
<td>✗</td>
</tr>
<tr>
<td>Print on specific areas when ZAE files have been previously prepared.</td>
<td>✓</td>
<td>✗</td>
</tr>
<tr>
<td><strong>Save, print and output</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>save as Studio Visualizer file which can be viewed with the free viewer program</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>print View Window</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>output high resolution snapshot image as JPG, PSD, PNG, TIF, TGA, BMP</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>output QuickTime movies, VR interactive views and image sequences</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Export Collada files (.dae) and Collada archives (.zae) for viewing</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Other</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color libraries of special finishes for Adobe Creative Suite and QuarkXPress</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
1.5 What’s New in Studio Visualizer 12

The following features have been added in this version:

**Avery Dennison Plug-in**
A new plug-in containing a library of label and packaging materials from Avery Dennison has been added. This library includes a sample of materials from Avery Dennison's extensive range.

**Preview images in Collada archives**
Studio Visualizer now produces ZAE files which include a preview image allowing other tools (e.g. WebCenter) to preview the contents.
2. Core Concepts

2.1 Exploring the Workspace

Below is a labeled picture of a typical session in Studio Visualizer:
<table>
<thead>
<tr>
<th>Item</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Process area</td>
<td>Used to manipulate the printing operations and finishes so that you can make immediate changes to your model and experiment with different effects and finishes;</td>
</tr>
<tr>
<td>2</td>
<td>View window</td>
<td>Displays the model, including any effects you have applied. The model can be rotated and moved around by dragging the mouse in the View window.</td>
</tr>
<tr>
<td>3</td>
<td>Create New Model button</td>
<td>Creates a blank model.</td>
</tr>
<tr>
<td>4</td>
<td>Open Model button</td>
<td>Opens an existing model or loads data from a PDF file.</td>
</tr>
<tr>
<td>5</td>
<td>Import Model button</td>
<td>Imports data from a PDF or structural design file (ArtiosCAD *.ard, Studio Toolkit for Flexibles *.bag, or Score! *.vlm files) into the current model.</td>
</tr>
<tr>
<td>6</td>
<td>Save Model button</td>
<td>Saves the current model.</td>
</tr>
<tr>
<td>7</td>
<td>Undo button</td>
<td>Rolls back the last change that you have made to your model.</td>
</tr>
<tr>
<td>8</td>
<td>Redo button</td>
<td>Re-applies the last change that you have undone by clicking Undo.</td>
</tr>
<tr>
<td>9</td>
<td>Reload Images button</td>
<td>Checks whether any of the images that you are using in your model have been recently modified. It</td>
</tr>
<tr>
<td>Item</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-----------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>allows you to replace any instances of changed artwork in your model with their respective updated versions.</td>
</tr>
<tr>
<td>10</td>
<td>Manual / Automatic Updates button</td>
<td>Determines whether or not changes you make in the operation stack are immediately reflected in the view window. Enabling Manual Updates means that you do not have to wait for the model to update each time you make changes in the operation stack. Instead, you may make several changes to the operation stack before updating the model correspondingly.</td>
</tr>
<tr>
<td>11</td>
<td>Display Uncut Flat Sheet button</td>
<td>Switch between display modes of a foldable model.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This feature is only available in the full version of Studio Visualizer.</td>
</tr>
<tr>
<td>12</td>
<td>Display Die-Cut Flat Sheet button</td>
<td>Switch between display modes of a foldable model.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This feature is only available in the full version of Studio Visualizer.</td>
</tr>
<tr>
<td>13</td>
<td>Display Folded Model button</td>
<td>Switch between display modes of a foldable model.</td>
</tr>
<tr>
<td>Item</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>14</td>
<td>Floating Model button</td>
<td>Switch between a Floating or a Standing model.</td>
</tr>
<tr>
<td>15</td>
<td>Standing Model button</td>
<td>Switch between a Floating or a Standing model.</td>
</tr>
<tr>
<td>16</td>
<td>Snapshot tool</td>
<td>Saves a static picture of your model, which you may send to others in order to communicate your design ideas.</td>
</tr>
<tr>
<td>17</td>
<td>Movie Output button</td>
<td>Saves an interactive or linear movie of your model. Alternatively, you can output a sequence of images from which a movie may be composed in Adobe Premier or another video editing software package.</td>
</tr>
<tr>
<td>18</td>
<td>Export 3D for Viewing button</td>
<td>Exports a Collada file (.dae) or Collada archive (.zae) for later viewing. You can also automatically upload the exported file to e.g. an FTP server</td>
</tr>
</tbody>
</table>

2.2 Toolbar Button Reference

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Create New Model button</td>
<td>Creates a blank model.</td>
</tr>
<tr>
<td>Button</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>🗂️</td>
<td>Open Model button</td>
<td>Opens an existing model or loads data from a PDF file.</td>
</tr>
<tr>
<td>🗂️</td>
<td>Import Model button</td>
<td>Imports data from a PDF or structural design file (ArtiosCAD *.ard, Studio Toolkit for Flexibles *.bag, or Score! *.vlm files) into the current model.</td>
</tr>
<tr>
<td>🔄️</td>
<td>Save Model button</td>
<td>Saves the current model.</td>
</tr>
<tr>
<td>🔄️</td>
<td>Undo button</td>
<td>Rolls back the last change that you have made to your model.</td>
</tr>
<tr>
<td>🔄️</td>
<td>Redo button</td>
<td>Re-applies the last change that you have undone by clicking Undo.</td>
</tr>
<tr>
<td>🔄️</td>
<td>Reload Images button</td>
<td>Checks whether any of the images that you are using in your model have been recently modified. It allows you to replace any instances of changed artwork in your model with their respective updated versions.</td>
</tr>
<tr>
<td>Button</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Manual / Automatic Updates button" /></td>
<td><strong>Manual / Automatic Updates button</strong></td>
<td>Determines whether or not changes you make in the operation stack are immediately reflected in the view window. Enabling Manual Updates means that you do not have to wait for the model to update each time you make changes in the operation stack. Instead, you may make several changes to the operation stack before updating the model correspondingly.</td>
</tr>
</tbody>
</table>
| ![Display Uncut Flat Sheet button](image) | **Display Uncut Flat Sheet button** | Switch between display modes of a foldable model.  
**Note:** This feature is only available in the full version of Studio Visualizer. |
| ![Display Die-Cut Flat Sheet button](image) | **Display Die-Cut Flat Sheet button** | Switch between display modes of a foldable model.  
**Note:** This feature is only available in the full version of Studio Visualizer. |
| ![Display Folded Model button](image) | **Display Folded Model button** | Switch between display modes of a foldable model.  
**Note:** This feature is only available in the full version of Studio Visualizer. |
| ![Floating Model button](image) | **Floating Model button** | A Floating Model is freely floating in front of the background,
<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Cube" /></td>
<td>Standing Model button</td>
<td>A Standing Model is standing on a reflective table surface. The table surface is based on the backdrop.</td>
</tr>
<tr>
<td><img src="image" alt="Camera" /></td>
<td>Snapshot tool</td>
<td>Saves a static picture of your model, which you may send to others in order to communicate your design ideas.</td>
</tr>
<tr>
<td><img src="image" alt="Clapperboard" /></td>
<td>Movie Output button</td>
<td>Saves an interactive or linear movie of your model. Alternatively, you can output a sequence of images from which a movie may be composed in Adobe Premier or another video editing software package.</td>
</tr>
<tr>
<td><img src="image" alt="Upload" /></td>
<td>Export 3D for Viewing button</td>
<td>Exports a Collada file (.dae) or Collada archive (.zae) for later viewing. You can also automatically upload the exported file to e.g. an FTP server</td>
</tr>
</tbody>
</table>

### 2.3 Environments and Backdrops

#### Environments

Studio Visualizer is the first software application that allows you to see realistic and dynamic 3D views of print effects and finishes on cards, cartons and other types of packaging. The reflections shown in your model will come from the currently enabled Environment.

Studio Visualizer comes with a number of 3D environments. Each has its own unique feel, determined by the number of lights and their intensity and position. By changing the environment you can get a feel for how your design will look in a particular location, whether it be at home, in the office, outside or even in a shop.
For example, the images below show a greetings card model in two different environments.

To change the current model’s environment click on **Scene > Environment**. This will display the sub-menu that contains all the available environments. Click on the one you would like to use in conjunction with the current model.

**Backdrops**

In Studio Visualizer, the light that shines on to your models comes from the current environment. However, you may like to put a custom image or color behind the model when creating a pack-shot, for example. Studio Visualizer allows you to do this, but it is important to realize that the light shining on your model (and therefore the reflections you see in it) will still come from the environment.

To change the backdrop to an image, click **Scene > Backdrop > Image > Browse...**

You will then be able to find an image to use as a backdrop. You will find that your 10 most recent backdrop images get added to the **Scene > Backdrop > Image** sub-menu for ease of use.

**Note:** Saving a Studio Visualizer model that is using an image backdrop will increase the size of that model file on disk as a copy of the image is stored inside the model file. This does, however, mean that you can send the file to someone who does not have the same image file and the model will still look identical.
3. Build a Model from a PDF

Studio Visualizer is able to create a model from a PDF. The elements of the PDF are mapped on to operations within Studio Visualizer. Loading or importing a PDF is a great way of getting results fast. Most graphics applications provide a way of exporting your artwork to a PDF and so this method of building a model is typically preferred.

If you have a Normalized PDF file that contains meta-data referring to a structural design file (*.ard, *.bag, or *.vlm), Studio Visualizer will be able to load the corresponding CAD data automatically, too. Otherwise, you will have to fold the model yourself using the Fold/Cylinder Settings tool.

3.1 Prepare the PDF

Studio Visualizer has the facility to generate your model automatically from a PDF file containing labeled pages or separations using a technology called Auto-build. An Auto-build compatible PDF file can be generated by common artwork packages, including Adobe Illustrator, Adobe Photoshop and QuarkXPress. Studio Visualizer can work with either pre-separated PDF artwork (one separation per page), or a composite PDF file containing separation color spaces.

The PDF loading and importing features work by examining the labels associated with each PDF page or separation and attempting to find an operation whose name matches the label. The matching process is clever enough to recognize partial matches and similar phrases to those used in the operation names. Thus it’s often not necessary to name the layers of your artwork in exactly the same way as the Studio Visualizer operations. However, the closer your names are to actual Studio Visualizer operation names, the better the matching will be.

- **Rename the layers in the PDF file** to match the Studio Visualizer operations.

  There are various ways that you can change the names of the elements that end up in a PDF file and they will vary depending on your work flow and choice of creative applications.

  Most creative applications provide a way to name each layer of your artwork. Alternatively, if you have Adobe Acrobat Professional, you can tweak the names once the PDF has been exported from your preferred graphics package.

- **Use the Palettes** bundled with Studio Visualizer

  Studio Visualizer comes bundled with a number of palettes for use in your favorite creative applications. By using these palettes you can make sure that your layers are named in such a way that Studio Visualizer will accurately match the elements of your PDF files against the operations provided by Studio Visualizer.

  If your creative packages are installed in the standard locations, you should find that Studio Visualizer will copy the palettes into those places automatically. However, on some computers, where you don’t have administrator privileges, you may have to copy the palettes in manually.

  The palette files can be found in /Applications/Studio Visualizer 10 on the Mac and C:\Program Files/Esko/StudioVisualizer10 on a PC (assuming you installed the software to the usual location).

  Copy the appropriate palettes into the corresponding directories for your creative applications in order to use them.
3.2 Load or Import the PDF

1. Do one of the following:
   - Click on the Import Model button to import data from a PDF into an existing model, or
   - Click on the Open Model button to create a new model from a PDF.

   The Open dialog opens, prompting you to select the PDF file containing the artwork for your model.

2. Once you have selected the PDF file that you would like use, click Open.

   The Autobuild Options dialog appears.

   ![Autobuild Options dialog](image)

   - Matching profile: [Generic Matching]
   - Language: [English]
   - Crop to: [Profile Default]
   - Resolution: [Profile Default]

   - Front:
     - [All]
     - [Pages]

   - Back:
     - [None]
     - [Pages]

   - [Don't show this dialog again]
   - [Reset]
   - [Cancel]
   - [Continue]

3. Set the appropriate auto-build options.
Some matching profiles may disable some of the options within this dialog if they are inappropriate.

4. Click Continue.

The auto-build process starts.

A model is constructed based on the separations of the PDF according to the options you’ve entered. Often, you will have to tweak and/or fold the resulting model.

Note:

When loading a PDF enriched with structural data and Esko metadata information from scratch, the file will also be scanned for any references to a structural design file (*.ard, *.bag, *.vlm, *.dae, *.zae) containing suitable structural information. If such a reference is found in the PDF, the structural data will be brought in to the model.

However, when importing data from a PDF file into an existing model, any structural design file references found are ignored.

Example PDF File

Studio Visualizer ships with an example PDF file that can be loaded to create the example model. Typically it is installed in:

- ~/Esko Visualizer 10 Examples/Esko Software Suite 10 box/Esko Software Suite 10 box.pdf on a Mac or
- C:\Program Files\Esko\Visualizer10\Examples\Esko Software Suite 7 box \Esko Software Suite 10 box.pdf on a Windows PC.

3.2.1 Autobuild Options in Detail

Autobuild Options dialog
To get back to the default auto-build settings, you can press Reset.

**General Options**

<table>
<thead>
<tr>
<th><strong>Option</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Matching profile</td>
<td>Determines how names of the PDF separations should be mapped onto Studio Visualizer operations. The default Generic Matching profile will do a reasonable job most of the time. Studio Visualizer plug-ins may include additional profiles that better match a specific set of operations which you may like to experiment with.</td>
</tr>
<tr>
<td>Crop to</td>
<td>Allows you to crop the substrate to a particular box defined by the PDF.</td>
</tr>
</tbody>
</table>
### Option

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>Determines the quality at which the PDF separations are rasterized. Auto-building at higher resolutions will require more memory and processing. The images will look better, but the auto-build process will take a little longer to complete. Higher resolution options may also degrade visualization performance on some older computers.</td>
</tr>
</tbody>
</table>

### Page Options

You may choose a range or several ranges of pages to apply to both the front and back faces of the model that will be auto-built. For example, to put the operations from pages 1, 2 and 3 on the front of the model and those from pages 4, 7, 8 and 9 on the back, the following details should be entered in to the Pages boxes of the Front and Back areas:

![Page Options](image)

### 3.3 Move, Rotate, Zoom and Pan the View Window

Once we add some print operations to our model, we will need to move the object or view around in order to see how the finishes catch the light from the environment.

For more information on viewing your model, see Viewing your Model

### 3.4 Tweaking and Folding

The PDF loader usually does a good job at matching up the elements in your PDF files to the appropriate print operations and finishes. However, the matching process sometimes has to guess and it may occasionally match up an inappropriate operation to a particular PDF element.

In this case you will need to tweak the operations. You may also want to fold the model at this stage, if the model hasn’t been folded already.

**Note:** If you have the Pro edition of Studio Visualizer you can also fold your model after the PDF file has been processed.

- To tweak the model, use the Operation Selector and the Operation Stack.
• To fold the model, use the Fold/Cylinder Settings tool.
Folding facilities are only available in the full edition of Studio Visualizer and not in Studio Visualizer for Labels.
4. Build a Model From Scratch

This is a step-by-step tutorial that explains how to create a Studio Visualizer model from scratch. We will be looking closely at building a new model one operation at a time, and learning about some of the more hands-on features of Studio Visualizer along the way.

If you have a PDF file containing separations, Studio Visualizer may be able to build your model for you automatically, starting from the PDF file, which is typically much quicker than creating the model in this way. However, even if you don’t have a PDF to hand, building models is still quick and easy.

4.1 Create a New Model

This task describes how to create a new model in Studio Visualizer, and how to use the basic viewing controls.

1. Start Studio Visualizer and click the New button in the startup dialog.
   
   You can also click the New Model button on the toolbar, choose File > New or press Cmd-N

2. Change the model’s dimensions if needed. To do so, click the button at the bottom of the Process Panel next to the Size information with the Substrate operation selected. Type the desired values in the Width and Height fields of the Sheet Size dialog.
3. Change the model’s color by clicking the Color field and selecting a color from the Choose a color dialog.

4. Save the new model by clicking the Save button on the toolbar.

Alternatively, you can use the Save or Save As commands in the File menu, or press **Cmd+S** on Mac OS or **Ctrl+S** on Windows.

### 4.2 Set the Substrate Material

A substrate material is always the first operation for each model. It is represented by a specific substrate operation appearing at the bottom of the stack. The same substrate is shared by the back and front print stacks.

By default, a substrate either takes its substrate information from a structural design file, or, in case there is no structural design file, a default paper substrate which is based on a gloss coated paper.

Substrates can be selected and changed in the **Substrate Selector**. The Substrate Selector will only show materials or operations that can be used as a substrate. To access the Substrate Selector, either double-click a substrate operation or click a substrate’s Type button in the **Process Panel**.

In this tutorial, we will change the default substrate material to a satin coated paper. However, Studio Visualizer can also simulate substrates such as metal, foil board, polyethylene, and more.

1. Double-click the default paper operation in the Operation stack.

   The **Substrate Selector** dialog appears. The Operations list only shows substrate materials.

2. At the top of the Substrate Selector, disable the option Use the substrate from the structural design file (default paper).

3. Select the standard materials substrate category. The right hand pane displays the contents of the selected substrate category.

4. In the right hand pane, select satin coated paper.

   As an alternative to browsing through the operation hierarchy in the left hand and right hand panes of the **Substrate Selector**, type the first letter(s) of the operation you want to apply in the search field at the top of the dialog and click **Find**.
Use the substrate from the structural design file (solid material).

If there is no structural design file, a gloss coated paper is used.

**Operations**

- standard materials
  - uncoated paper
  - thin paper
  - matt coated paper
  - **satin coated paper**
  - gloss coated paper
  - high gloss coated paper
  - textured paper
  - coarse textured paper
  - corrugation effect paper (vertical)
  - corrugation effect paper (horizontal)
  - foil board
  - metal
  - metallized backing
  - clear PET
  - opaque rigid PE
  - flexible PE
  - plastic film
  - glass
  - split papers
  - label materials
  - PANTONE MATCHING SYSTEM®
  - SAKATA INX plug-in
  - ECKART metallic inks

**Information**

- **satin coated paper**
  - satin, coated paper with a texture of adjustable depth

**Operation parameters**

- texture depth
  - 0
  - 50
  - 7

**Colors**

- R: 255
- G: 255
- B: 255
The Substrate Selector now displays the properties for the selected operation: the Information area shows a basic description, the Color Picker displays the substrate color, the Operation parameters displays any additional parameters (in this case, a slider controlling the texture depth of the paper).

5. If necessary, change the paper color by clicking in the Color Picker.
6. Click Finish to apply the substrate material to the model.

The model now has a substrate applied to it, and the View window displays the result for both the front and back faces.

4.3 Fold the Model

Studio Visualizer can determine the size that your model should be from a PDF file that contains separations. The two-dimensional model can also be transformed into a folded 3D box using the powerful folding features of Studio Visualizer.

Note: It is only possible to fold your model in the full edition of Studio Visualizer. If you are running Studio Visualizer for Labels, you will not be able to fold models based on CAD structural design files.

In this tutorial, we will be using the example files that can be installed with Studio Visualizer: the Esko Software Suite 10 box example. Each page in this PDF file contains a mask image that will be used to apply a particular finish or effect to a region of the model.

The Esko Software Suite 10 box PDF file contains two separations indicating the net layout of the package, which we will use now to help us set the dimensions of the model and then again to tell Studio Visualizer how the model should be folded.
1. Select the substrate material operation in the **Operations stack**. In our example, select the satin coated paper operation.

New operations are always added on top of the selected operation. This means that you always have to make sure you have the appropriate operation selected in the stack before you add any new operations.

2. Click the **Insert Operation** button in the **Actions** panel.

The **Operation Selector** dialog appears.

3. Select the **spot color** operation in the **process and spot color** category.

4. Click on the **Artwork Selector** button at the bottom of the **Operation Selector** dialog to select an image mask that will be used to determine exactly where the spot color gets applied to our model.

A file browser dialog appears.

**Note:** If no file browser appears, click the Add button underneath the Images Files area of the Artwork Selector dialog.

5. Select the **Esko Software Suite 10 box.pdf** file and click **Open**. This file is typically installed in the following location:

- ~/Esko Visualizer 10 Examples/Esko Software Suite 10 box/Esko Software Suite 10 box.pdf **on Mac OS**; or
- C:\Program Files\Esko\Visualizer10\Examples\Esko Software Suite 10 box \Esko Software Suite 10 box.pdf **on Windows**.

If you installed the Studio Visualizer sample files to a different location, please browse there instead.
The Esko Software Suite 10 box PDF will be displayed in the Artwork Selector dialog. The Image Files area of the Artwork Selector dialog contains all the files that you have opened so far. The Image Contents area shows all the images that the selected file contains. In this example, a number of images will have been loaded from the Esko Software Suite 10 box PDF.

6. Select the Artios Cut and Artios Crease images from the PDF by clicking the corresponding box in the Image Contents area.

   All the images used in the tutorial will come from this single PDF file but the artwork selector can in fact load images from a variety of formats, not just PDFs.

7. Make sure the Esko Software Suite 10 box PDF is selected in the Image Files area, then click the Set Size button.

   Studio Visualizer calculates the physical dimensions of the model based on the mask image you selected.

8. Click Finish.
The spot color operation is applied to the front face of the model and it the operation appears at the top of the Operation Stack.

9. Choose **Model > Edit Fold/Cylinder Settings** (or press **Ctrl+Shift+F** on Windows or **Cmd+Shift+F** on Mac OS).

   The **Fold/Cylinder Settings** dialog appears.

10. Click the Folded Box tab, and drag a selection over the front face of the box.
Fold / Cylinder Settings

- Folded box
- Cylinder
- Structural design

- New click on the arrows to add additional faces. You can also click and drag lines to resize the folded box.

Layout view

Dimensions
- Width: 205.3
- Height: 247.8
- Depth: 30.0

Options
- Clamp to slab

Viewing controls
- Zoom: 

Set layout

Cancel
The front face of the box is now indicated. You can define the other face of the box by clicking on the arrows surrounding the front face, or refine the front face's size by dragging its handles.

11. Click the bottom arrow and define the underside of the box.
You can click on the arrows to add additional faces. You can also click and drag lines to resize the faces.

**Dimensions**
- Width: 205.3
- Height: 247.8
- Depth: 36.7

**Options**
- Clamp to sheet

**Viewing controls**
- Zoom: [ ]

[Fit to window] (button)
12. Using the same technique of clicking the arrow, dragging and refining the shape, add the Left, Right, Top and Back faces in that order.

Refining the size and position of a specific shape may affect the size of other faces.

**Note:** Use the Zoom buttons to zoom in on the Layout view to make sure the faces have been accurately aligned to the 3D design.

13. Click OK.

Studio Visualizer will now fold the model using the layout that we have defined. When rotating the model you should now see it is a fully 3D box.

14. Hide the cut and crease lines from the model by turning off the spot color operation in the Operation Stack.
The model is now complete.

4.4 Add Process Colors

In this tutorial, you will add a process color to the model.

1. Select the top-most operation of the front face in the Operation Stack.
2. 
   Click the Insert Operation button in the Actions panel.
   The Operation Selector dialog appears.
3. Select the process color (litho) operation in the process and spot color category.
4. Click the Artwork Selector button.
5. Do one of the following:
   • If you already have the Esko Software Suite 10 box PDF loaded in the Image Files area, click on it.
   • If the Esko Software Suite 10 box PDF is not listed in the Image Files area, click the Add button. A file browser dialog appears. Use it to browse to and select the sample file.
7. Click Finish.
A process color operation is added to the top of the Operation Stack, and the 3D View is updated.

### 4.5 Add Spot Colors

In this tutorial, you will add a spot color operation to the model, using a color from the PANTONE® MATCHING SYSTEM®.

1. Select the top-most operation of the front face in the Operation Stack.
2. Click the Insert Operation button in the Actions panel. The Operation Selector dialog appears.
3. Type Pantone 7546 in the Find field and click Find. The Pantone 7546 spot color operation is selected.
4. Click the Artwork Selector button.
5. Do one of the following:
   - If you already have the Esko Software Suite 10 box PDF loaded in the Image Files area, click on it.
   - If the Esko Software Suite 10 box PDF is not listed in the Image Files area, click the Add button. A file browser dialog appears. Use it to browse to and select the sample file.
6. Select the Pantone 7546 image in the Image Contents area and click Finish.
A spot color operation is added to the top of the **Operation Stack**, and the 3D View is updated.

### 4.6 Add Special Finishes

To further polish the model, we can add some special finishes, such as metallic inks, varnishes or an emboss.

In this tutorial, you will add a varnish to the model.

1. Select the top-most operation of the front face in the Operation Stack.
2. Click the **Insert Operation** button in the **Actions** panel. The **Operation Selector** dialog appears.
3. Browse to the **gloss spot UV varnish** operation in the **varnishes** category. The operation is selected, and the operation preview appears.
4. Click the **Artwork Selector** button.
5. Do one of the following:
   - If you already have the Esko Software Suite 10 box PDF loaded in the **Image Files** area, click on it.
   - If the Esko Software Suite 10 box PDF is not listed in the **Image Files** area, click the **Add** button. A file browser dialog appears. Use it to browse to and select the sample file.
6. Select the **gloss spot uv varnish** image in the **Image Contents** area and click **Finish**.
7. Once the operation is applied, try enabling and disabling it to see the difference that the varnish makes. Also try adjusting the thickness of the varnish by moving the slider in the current operation section of the process area.
4.7 Build a Model From a Structural Design File

When given a structural design (CAD) file as part of a design brief, it is often a good idea to familiarize yourself with the shape of the product before starting on the artwork. Once you are comfortable with the shape of the package and feel ready to start applying artwork, you can begin the design in earnest.

Studio Visualizer can build models based on the following structural design file formats:

- ArtiosCAD *.ard files;
- Studio Toolkit for Flexibles *.bag files for flexible packaging such as bags and wrappers;
- Score! *.vlm files.
- Collada *.zae archives with arbitrary 3d shapes, with printable areas defined (if supplied by EskoArtwork products). Collada archives created by non-EskoArtwork products can be used in Studio Visualizer but will not have a printable area.

We recommend using the Esko DeskPack plug-ins for Adobe Illustrator which allow you to create artwork directly on top of an ARD template and export a PDF file through Esko Automation Engine server.

You can then iteratively import the changes made in Studio Visualizer by clicking on the Import button and browsing to the appropriate PDF document. The changes made to PDF will be reflected in the model.

**Note:** When Studio Visualizer imports a PDF file, it does so intelligently. Rather than adding an entirely new set of operations on to the existing operation stack, operations are instead merged in to the current set.
1. To start designing around a structural design file in Studio Visualizer, click the Import button on the toolbar and browse to:
   - an ArtiosCAD *.ARD file;
   - a Studio Toolkit for Flexibles *.BAG file; or
   - a Score! *.VLM file.
   - a Collada *.DAE file or Collada *.ZAE archive

2. Click Open to import the structural design file.

   The Fold/Cylinder settings dialog appears.

3. If necessary, you can Rotate or Flip the die shape.

4. Click OK to apply the structural design to your Studio Visualizer model.
5. Viewing your Model

5.1 Studio Visualizer in View Mode

Studio Visualizer has two modes of operation. These modes of operation are Design mode, where changes may be made to the current model and View mode where no changes may be made but the model may still be moved about dynamically in order to see your designs.

Studio Visualizer running in View mode is pictured below.

5.2 Move, Rotate, Zoom and Pan the View Window

You can move the object or view around in order to see how the finishes catch the light from the environment.

- **Move** the model around by clicking in the View window and holding down the left mouse button while dragging the model around.
- **Rotate** the view by dragging in the View window with the right mouse button.
  
  If your mouse does not have a right-click button you can rotate the view by holding down the Ctrl key on Mac OS or the Alt key on Windows while dragging.
- **Zoom** in and out by rotating the mouse wheel if you have a wheel mouse.
If your mouse does not have a wheel, you can zoom the view by holding down the \texttt{Cmd} key on Mac OS or the \texttt{Ctrl} key on Windows while dragging.

- **Pan** the camera up, down, left and right by holding down the \texttt{Shift} key and dragging the mouse in the View window.
- Adjust the **angular field of view** for the camera by holding down \texttt{Cmd+Shift} on Mac OS or \texttt{Ctrl+Shift} on Windows and dragging the mouse up or down in the View window.

You can restore the original view angle by double-clicking in the View window with the right mouse button.

### 5.3 Setting the Scene

The scene determines how your model is shown. All settings are made in the Scene menu.

#### 5.3.1 Setting the environment

In Scene > Environment you can choose the environment in which you want to see your model. Visualizer contains an elaborate list of predefined environments, some "real life" environments, others resembling photo studio circumstances.

An environment consists of a background (such as a warehouse, a shop, ...) and specific lighting settings.

**Note:**
Even if the background is not visible because of a defined backdrop, the model is still shown using the lighting settings of the selected environment.

#### 5.3.2 Using a backdrop

You can define a backdrop in Scene > Backdrop. A backdrop can be a color, or an image. A backdrop is positioned between the model and the environment background. It does not change the lighting from the environment.

#### 5.3.3 Standing model versus Floating model

In the Scene menu, you can choose between a Floating Model or a Standing Model. You can also use the buttons in the toolbar.

A Floating Model is freely floating in front of the background, and can be turned in every direction.
A Standing Model is standing on a reflective table surface. The table surface is based on the backdrop. Therefore the **No Backdrop** option will be disabled, and the environment background will not be visible.

**Note:**

Although the Environment background is not visible, the selected Environment still defines the lighting and highlights.

For a standing model, moving the view is restricted, as the model always remains on the table, so you will have no tilt.

**Table reflection for a Standing Model**

When using a **Standing Model**, you can define the Table Reflection in **Scene > Table Reflection**.
The **Opacity** sets the opacity of the reflection.

If **Fade** is enabled, the reflection will fade out, on the selected **Position** and over the selected **Size**.

**Note:**

This Fade is a 2D effect in the view, so it might not always give the expected result.
6. Communicating Your Designs

There are two ways to communicate your designs: you can distribute Studio Visualizer in View mode, or you can create movies that can be viewed in the Quicktime media player.

6.1 Creating Movies of Your Models

Why create movies?
When you have created and edited your model, you may want to communicate your design ideas to others. A great way to do this is to create a QuickTime movie which another person may view on their own computer or from a web-page.

You can generate both linear and interactive movies from within Studio Visualizer. This is a great way of presenting your ideas in a dynamic way, because the viewer will be able to see how the surfaces of the model interact with light from the surrounding environment. It is also possible to generate animation frames as a sequence of images for those that like to compose their own videos in Adobe Premiere or similar movie editing packages.

Quicktime file types
Studio Visualizer allows you to create two types of movies: QuickTime VR and QuickTime mov files. QuickTime VR files are interactive movies that when loaded in QuickTime player, may be dragged by the user to rotate the model. QuickTime mov files are simply linear animations that play from start to finish and offer no opportunity for user interaction.

Note: You can download the QuickTime Player free from the www.apple.com/quicktime/download web site.

6.1.1 Movie Types
You can save four types of movies from within Studio Visualizer:

- **Interactive**, which exports an interactive QuickTime VR movie.
- **Horizontal motion**, which records a movie of your model spinning about a vertical axis.
- **Vertical motion**, which records a movie of your model spinning about a horizontal axis.
- **Gyration**, which records a movie of your model where the front face spreads outwards as it rotates.

Each type of movie has a different set of properties that can be defined in the Movie Setup dialog.

6.1.2 Save a Movie

1. Choose *Output > Movie.*
The **Movie Setup** dialog appears.

2. Do one of the following:
• Choose a Preset from the list to quickly retrieve a previously saved movie setup.
• Select a Movie Type from the list and set all the appropriate properties.

3. If you would like to see what the movie is going to look like with your current settings, without actually saving it, click the Preview Frames button.

   Studio Visualizer will move your model to show what the movie will look like once saved.

   **Note:** You can press Esc at any time to stop generating the frames.

4. Click OK.

   The Save Movie As dialog appears.

5. Type a File Name and click Save.

   The movie file or individual image frames are saved.

   **Note:** You can press Esc at any time to stop generating the frames.

### 6.1.3 Save a Movie Preset

The Movie Output tool has a number of user-definable settings. Once you have experimented to find some that you like, you may wish to save them as a Preset for future use.

1. Choose Output > Movie.
The Movie Setup dialog appears.

2. Define all the settings you want to save as a Preset.

3. Click Save.
The Save Preset dialog appears, prompting you for a name.

4. Type a name for the preset and click OK.

The preset is added to the Presets list.

You can delete an existing preset by selecting it from the list, and then clicking Delete.

### 6.1.4 Output Format Options

Studio Visualizer allows you to choose from a variety of options in relation to the formatting of the media generated by the Movie Output tool.

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Movie and image formats</td>
<td>Presents a choice of formats in which you may save your output. For each of the four types of movie, you can choose from a variety of image formats in which the movie frames will be saved. Additionally, for Interactive movies you may choose QuickTime VR to create an interactive movie and for all other types of movie, you may choose QuickTime mov</td>
</tr>
<tr>
<td>2 Compression options</td>
<td>Allows you to choose a particular compressor for output. When clicked, this opens the Advanced Compression Options dialog, in which you can select a</td>
</tr>
</tbody>
</table>
6.1.5 Movie Size Options

You may output your movie file or the individual frames to any dimensions that will fit inside your Studio Visualizer work area. By default, the size of the current view window will be used for output. This may be changed by either selecting a common video-size from the Output dimensions list in the Output Format area of the Movie Setup dialog, or by entering the size yourself in the Width and Height boxes just below.

Studio Visualizer restricts any dimensions you enter to fit inside your workspace. The last entry in the Output dimensions list is the maximum allowed video size. This is necessary for correct video capture.

Tip: If you move the Process panel and toolbar so that they’re floating, or hide them temporarily from the window menu you will be able to use slightly larger output dimensions.
6.1.6 Interactive Movies in Detail

What is an interactive movie?

The Interactive movie type allows generation of either a QuickTime VR movie file or the individual frames that would go in to making such a movie. Using an interactive movie you can create a realistic model that may be sent to others. It may be moved and rotated with the mouse by clicking and dragging.

Example

Rotation types

QuickTime VR interactive movies allow the person viewing them to rotate the model horizontally and/or vertically. Each of these rotation types may be done around:

- **the model's** horizontal or vertical axis; or
- **an axis that is horizontal/vertical in relation to the view.**

Figure 1: Horizontal rotation about the model's vertical axis
Figure 2: Horizontal rotation about an axis that is vertical according to the camera/view

Options for interactive movies
<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal extent area</td>
<td>Set the total number of degrees left-to-right that the model will be rotated. A setting of 20 degrees means that it will be possible to rotate the model 10 degrees in each direction. The number of degrees swept left and right will be divided into a certain number of frames or steps. The higher the number of frames, the smoother the movement will be (and the larger the file size).</td>
</tr>
<tr>
<td>Vertical extent area</td>
<td>Set the total number of degrees top-to-bottom that the model will be rotated. A setting of 20 degrees means that it will be possible to rotate the model 10 degrees in each direction. The number of degrees swept left and right will be divided into a certain number of frames or steps. The higher the number of frames, the smoother the movement will be (and the larger the file size).</td>
</tr>
<tr>
<td>Rotate relative to area</td>
<td>Defines the rotation axis: either relative to the model, or to the view camera.</td>
</tr>
</tbody>
</table>
Tip: Two degrees per step/frame provides a good resolution of movement: you may find that going to one degree per step gives negligible improvement. At three degrees per step, you start to notice the step between frames.

Note: If you want a frame captured every two degrees over a 20-degree sweep, you will need 11 steps rather than 10: this allows for a frame at the central position of zero degrees.

6.1.7 Horizontal and Vertical Movies in Detail

What is a horizontal or vertical movie?
The Horizontal movie and Vertical movie output types have the same controls but they correspond to horizontal and vertical motion respectively. Each provides options to generate either a linear Quicktime movie, or the individual frames that would go in to creating such a linear movie.

Examples

Options for horizontal and vertical movies

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>degrees</td>
<td>Sets the total angle through which the model will rotate. A setting of 20 degrees means that the model will be rotated from -10 to +10 degrees in the generated movie or across the generated frames.</td>
</tr>
<tr>
<td>seconds duration</td>
<td>Sets the number of seconds that the whole rotation movement will take. Use a lower number for a short</td>
</tr>
</tbody>
</table>
### Component Function

- **frames per second**: movie with fast movement, or a longer duration for a longer movie with slower movement.
- **Looping**: Determines how smooth the movie will appear when played: higher values result in better quality but larger file sizes.
- **Ping-pong**: Sets QuickTime player to loop the movie automatically.
- **Acceleration**: If enabled, the rotation will reverse at the end of the motion so that the model returns to the position in which it started. Using *Ping-pong* implies that the movie will be twice as long and will have twice as many frames, which in turn means that the generated movie file will be bigger.
- **Rotate relative to area**: Defines the rotation axis: either relative to the model, or to the view camera.

**Tip:** Horizontal and Vertical movies are great for displaying all sides of your model. Try changing the settings to 360 degrees over a time of four seconds. Make sure you turn *Ping-pong* and *Acceleration* off. When the completed movie is opened in QuickTime player, you'll be presented with a model that is continually spinning to show all its faces.

## 6.1.8 Gyration Movies in Detail

**What is a Gyration movie?**

The Gyration movie type allows you to create a movie where the front face is 'wobbled' around in a circle to display how the light is interacting with it.

**Example**

**Options for horizontal and vertical movies**
Component | Function
---|---
Spread angle | Sets the total angle through which the model will rotate. A setting of 20 degrees means that the model will be rotated from -10 to +10 degrees in the generated movie or across the generated frames.

Duration | Sets the number of seconds that the whole rotation movement will take. Use a lower number for a short movie with fast movement, or a longer duration for a longer movie with slower movement.

Frame rate | Determines how smooth the movie will appear when played; higher values result in better quality but larger file sizes.

6.2 Export 3D file

Using the **Export 3D file for Viewing** function, you can export your job as a Collada file (.dae) or as a Collada archive (.zae).

Collada is a COLLABorative Design Activity for establishing an interchange file format for interactive 3D applications.

- a [Collada](#) file (.dae) contains the 3D geometry of the design, but may link to a number of external artwork files or other .dae files.
- a [Collada](#) archive (.zae) file is an archive that contains the original Collada file (.dae), all additional artwork and material files, and additional information.
6.2.1 Exporting a 3D file for viewing

1. Click the Export 3D for Viewing button or choose Output > Export 3D file for Viewing

2. Select the Type of file to export: either a Collada (.dae) file or a Collada archive (.zae)
3. If you want to create a jpeg preview file along with the Collada file, enable Create a preview image alongside
4. Select the Destination: either as a local file or uploading to a site.

Note:
By changing the extension of the .zae file to .zip, you can extract the file and view or use the individual files.
When Uploading to a site, you can select a Site from the dropdown menu. You can click the Manage Sites button to open the Online Preferences and define Collada upload Sites. See Setting up Collada Upload Sites.

5. Click the Save As button, and enter the name and location for the file to be saved.

6.2.2 Setting up Collada Upload Sites

If you want to export Collada files directly to a site, you must define the Collada Upload Site(s).

Either click the Manage sites button in the Export 3D File for Viewing dialog, or go directly to Edit > Preferences > Online (Windows) or Studio Visualizer > Preferences > Online (Mac).
• Click **New Site** to add a new Site to the list.
• Select a site in the list, and click **Rename** to change the name as it is presented in the list.
• Select a site in the list, and click **Delete** to remove it from the list.
• Select a site in the list, and click **Copy** to duplicate the site. This can be used to define a new site based on the settings of another one.
• Select a site in the list, and define or modify the Site details.
• the Type (FTP)
• The Host and Port number
• User Name and Password
• Remote directory
• Access URL: If you access the uploaded FTP data via HTTP for example, you can specify that HTTP URL here. After uploading, a link will be made using this access URL, which can be copied to the clipboard.
• Select a Site in the list, and click the Test Connection button to test the connection to the selected site.
7. The Tools in Detail

In this section, you will find detailed descriptions of the most important tools in Studio Visualizer: the Operation Stack, the Operation Selector dialog, the Artwork Selector dialog and the powerful View presets.

7.1 The Operation Stack in Detail

Components of the Operation Stack
Component | Function
--- | ---
1 | Insert a new operation
2 | Remove the selected operation
3 | Move the selected operation up in the stack.
4 | Move the selected operation down in the stack.
5 | Select the face you want to edit.
6 | Enable or disable this operation.
7 | Change or edit the selected operation.
8 | Change the selected operation's parameters.
9 | Change or edit selected operation's artwork.

The **Operation Stack** can be found in the process area which is to the left of the Studio Visualizer main window by default. The **Operation Stack** contains an ordered list of print operations that simulate the processes that would be applied at a printing house.

Each face of your Studio Visualizer model has its own operation stack. You can change the current face by clicking the drop-down box at the top of the operation stack area.

### 7.1.1 Add an Operation to the Stack

1. Select the top-most operation of the front face in the Operation Stack.
2. Click the **Insert Operation** button in the **Actions** panel.
   
   The **Operation Selector** dialog appears.
3. Browse to the operation you want to apply, or use the **Find** box and button to search for it.
4. Click the **Artwork Selector** button.
5. Select the image you want to use as a mask for the operation in the **Artwork Selector** dialog, and click **Finish**.
The operation is added to the top of the Operation Stack.

### 7.1.2 Edit an Operation in the Stack

You can either open the Operation Selector for a given operation, and make any changes to the operation in that dialog, or you can edit the basic properties of the selected operation in the Current Operation area of the Process panel.

1. Do one of the following:
   - Double-click on the operation entry in the Stack;
   - Click the type button in the Current operation section of the process area.

   The Operation Selector dialog appears.

2. Make any required changes to the operation and click Finish.

### 7.1.3 Remove an Operation from the Stack

1. Select the operation you want to remove from the Operation Stack.

2. Click the Remove Operation button, or press Ctrl+D.

   The operation is deleted from the Operation Stack.

### 7.1.4 Move an Operation Up or Down

The operations in the Operation Stack may be re-ordered if so desired. The changes in order will be reflected in the 3D view of your model. The higher the operation appears in the Operation Stack, the later it is applied in the virtual printing process.

1. Select the operation you want to move in the Operation Stack.
2. Click the *Move Operation Up* or *Move Operation Down* buttons until the operation is in the desired position.

### 7.1.5 Reloading the Images for an Operation

If the current operation in the **Operation Stack** has an image associated with it, you will see some additional controls at the bottom of the Process area.

The **Reload Image** button will look to see if the original image used for the operation has changed on disk since the operation was first applied. If it has, the image is reloaded and the effects of the operation are updated accordingly in the 3D view window.

![source image](source_image.png) ![print effect](print_effect.png)

**Note:**

There is also a **Prevent Reload** option. This stops the **Reload Images** button on the toolbar from updating the images for this operation if they have changed on disk.

This means that the **Prevent Reload** option in the **Current Operation** area does **not** prevent the adjacent **Reload Image** button from updating the operation's images; it only applies to the **Reload Images** toolbar button!

### 7.2 The Fold/Cylinder Settings Tool in Detail

**The dialog: three tabs**

The Fold/Cylinder Settings dialog has three tabs:

- The first tab, **Folded box**, allows you to fold a flat sheet into a cuboid.
- The second tab, **Cylinder**, allows you to wrap a flat sheet into a full or partial cylinder.
• The third tab, Structural Design, allows you to import folding and layout information from a structural design (CAD) file.

7.2.1 The Folded Box Tab

Overview
When looking at the unfolded box in the Fold/Cylinder Settings dialog, the future dimensions of the 3D model are displayed in the Width, Height and Depth fields within the Dimensions area. These change dynamically as you adjust the layout.
click on the arrows to add additional faces. You can also click and drag lines to resize the faces.
You can also directly edit the numbers within the Dimensions area to set the exact dimensions of the model. This will adjust the net shown in the Layout view area.

**Extending the boundaries**

When using the Fold/Cylinder Settings dialog to create a box, it is possible to define sides of the 3D model such that the net extends over the boundaries of the underlying material.

In this case, the default behaviour is to simply cut off the areas of the net that do not fall within the 2D boundaries. The alternative behaviour, which is to use the geometry color, can be used by disabling the option **Clamp to sheet size**.
click on the arrows to add additional faces. You can also click and drag lines to resize the faces.
When creating your box layouts in the Fold/Cylinder settings tool, you **start with the front face and may work your way outwards** in any direction.

However, it may be the case that you want to change which face is which in the layout that you’ve defined. To do this, click on the text in the middle of the Front face defined in your layout to get a pop-up menu.
The pop-up menu allows you to change the front face to one of the other 5 faces. Doing so will change the face labels accordingly.

Clicking on the green arrow inside the front face will allow you to change the orientation of the faces by bringing up another pop-up menu.
7.2.2 The Cylinder Tab

The Preview area

The Preview area of the Cylinder tab shows how the flat model will be wrapped into a cylinder, or partial cylinder.

By default Studio Visualizer will create a full cylinder with a vertical axis by calculating the correct radius; that is, the left and right edges of the substrate will be made to touch at the back of the cylinder. Alternatively, you may instead roll the substrate into a horizontal cylinder such that the top
and bottom edges of the substrate will meet at the back. This is done by clicking on the **Horizontal cylinder** option, located in the **Dimensions** area.

Figure 3: Horizontal cylinder preview

Figure 4: Vertical cylinder preview
Refining the cylinder

Sometimes you may want only a part of a cylinder (for a bottle label, perhaps) and not a full cylinder. Or, you might want to ignore part of the artwork so that we may wrap the remainder around a tighter cylinder.

To do this we should stop Studio Visualizer from calculating the radius automatically by disabling the Make full cylinder check-box. With Make full cylinder disabled, you can change the value in the Radius box. If you enlarge the radius, the preview diagram will update to show the curvature of the cylinder segment that will be created. By making the radius smaller than the full-cylinder value, the Preview
area will show red cross-hatching over the area that won’t appear due to overlapping. These cases are pictured below.

Figure 5: Cylinder with a small radius; part of the artwork is hatched out

Figure 6: Cylinder with a large radius; part of the cylinder is hidden
When a small radius is used such that one end of the sheet is obscured due to overlap, you can decide which end of the sheet is obscured by selecting **Overlap** or **Underlap**:

- For a vertical cylinder this describes where the right edge of the sheet is placed in relation to the left edge.
- For horizontal cylinders this describes whether the right edge of the sheet overlaps or underlaps the left edge, for vertical cylinders this describes whether the bottom edge overlaps or underlaps the top edge of the sheet.

**Rotation point**

The purple X in the Preview area shows the point about which the cylinder will be rotated back in the 3D view window. This point can be quite far away from the generated segment when large radius values are used.

However, we can choose whether to use the center of the 'ideal' cylinder or the center of the segment as the axis of rotation by clicking either the **Center of cylinder** or **Center of segment** option in the **Viewing rotation axis** area.

### 7.2.3 The Structural Design Tab

**Import structural design files**

This tab comes in to play when you click on the **Import** button or the **Open** button, and select an structural design file in the browser window that appears.

Studio Visualizer will import the layout defined in the CAD file and allow you to align it over the unfolded sheet, in much the same way as seen in the **Folded box** tab.
Use click & drag to align the structural design layout with your artwork. Use arrow keys for fine adjustment.
Controls

Drag the imported net over your artwork to align it correctly. You can use the arrow keys on the keyboard to nudge the net in steps of 0.1 millimeters. If you hold down the Shift key while pressing the arrow keys the net will move in one-millimeter steps, instead.

If you need to make fine adjustments to the alignment, you might find zoom mode useful. Enable Zoom mode by clicking on the magnifying glass button. Once in Zoom mode, clicking the left mouse button in the Layout view area will now zoom in and clicking the right mouse button will zoom out.

Click the Fit to window button to zoom out to view the entire sheet. To exit zoom mode, click on the Arrows button.

You can rotate the net in 90 degree steps using the rotation buttons in the Positioning area. If the Flip die option is selected, the net is mirrored.

You may change the structural design data at any time by clicking on the Change button.
**Viewing folded or die-cut models**

Use the Display Die-Cut Flat Sheet and Display Folded Model buttons on the toolbar to switch between display modes.

*Figure 7: Die-cut flat sheet display of an ArtiosCAD model*

*Figure 8: Folded display of an ArtiosCAD model*
7.3 The Operation Selector in Detail

Operations are representations of the print effects and finishes that may be applied to your Studio Visualizer models. The Operation Selector dialog, in combination with the Artwork Selector dialog, provide a means of choosing operations to apply to your model.

The Operation Selector is shown when you are adding a new operation to your model, or editing an operation that is already being used in your model.

**Note:** Some operations are only available in the more advanced editions of Studio Visualizer.
Components of the Operation Selector

1. [Image of Operation Selector]
2. [Image of Color Wheel]
3. [Image of Color Slider]
4. [Image of User Interface Elements]
5. [Image of Information]
6. [Image of Operation Parameters]
7. [Image of User Interface Elements]
8. [Image of User Interface Elements]
<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Browse back</td>
</tr>
<tr>
<td>2</td>
<td>Browse forward</td>
</tr>
<tr>
<td>3</td>
<td>Browse up</td>
</tr>
<tr>
<td>4</td>
<td>Operation finder tool</td>
</tr>
<tr>
<td>5</td>
<td>Color picker, Operations folder view, or Operation preview</td>
</tr>
<tr>
<td>6</td>
<td>Operation parameters area</td>
</tr>
<tr>
<td>7</td>
<td>Save current operation as a user operation</td>
</tr>
<tr>
<td>8</td>
<td>Remove operation from the user operations category</td>
</tr>
<tr>
<td>9</td>
<td>Information area</td>
</tr>
<tr>
<td>10</td>
<td>Operations tree view</td>
</tr>
<tr>
<td>11</td>
<td>User operations category</td>
</tr>
</tbody>
</table>

The **Operation Selector** organizes all the operations available in to a hierarchy. On the left hand side of the **Operation Selector** dialog, the operations tree view presents this hierarchy in the form of a tree. Here you can expand folders and browse for an appropriate operation to apply to your model.

Below the operations tree view, there is an **Information** area, which will often provide you with a brief explanation of the currently selected operation, as well as providing some appropriate clickable links through which you may find out more information about the operation at hand.

In the lower right-hand corner of the operation selector window there is an **Operation parameters** area. In here, any parameters pertinent to the currently selected operation are shown and may be modified by using the slider or the text-entry box.

The upper portion of the right hand side of the operation selector window displays context-dependent information and controls that are related to the currently selected entry in the operations tree view. There are three possible things that might appear in this area:

- The Color Picker;
- The operations folder view;
- An operation preview.

### 7.3.1 The Color Picker

**Color wheel**

The color picker appears in the right-hand side of the operation selector window when an operation is selected in the operations tree view that requires a color in order to fully define it.

The most striking feature of the color picker is the color wheel. To select a color, you may click anywhere in the color wheel’s ring to choose your desired hue. The triangle will change accordingly to show the full range of saturation and value levels for that hue.
Tip:

Some tips for using the Color Picker:

- HSV, RGB and Lab are color spaces: different ways of representing a color using a combination of numerical values. You may change between HSV and RGB sliders by clicking on the tabs provided.
- RGB is a color space that you may be familiar with - it defines color as a combination of Red, Green and Blue values. HSV stands for Hue, Saturation, Value. If you are unfamiliar with the HSV and Lab color spaces, you can use the RGB sliders provided just below the color wheel.
- Colors entered in the Lab tab represent CIE Lab values with a D50 white-point and 2 degree observer.

Tip: If you prefer, your operating system’s native color picking tool may be used by clicking on the System Picker button.

Below the System Picker button, there is a block of color. The top half of the block displays the color that was displayed when the color picker was first shown. The bottom half of the block displays the color that is currently selected. Double clicking on the top half of the color block will restore the color picker to the color that was originally shown.

These color blocks make it easy to see the effects of small changes made to a given color.
Color palette

Below the color blocks is a color palette. The color palette may be employed to store colors that are used frequently throughout your project for easy access. To add a color to the palette, you may drag-and-drop colors from the color blocks in to the desired cell of the palette. Also, clicking on the lower color block adds the currently displayed color to the first non-white cell of the palette (or the first cell if there are no white cells available). Colors may be dragged between palette cells for further organization.

7.3.2 The Operation Folder View

When an operations category is selected in the operations tree view (or when nothing at all is selected), the right hand side of the operation selector window will display the contents of the category in question. This may contain further operations sub-categories or actual operations.
You can think of the operations tree view and operations folder view as a kind of file browser (as found on Microsoft Windows or Mac OS X); the operations tree view provides an overall picture of the layout and high-level navigation facilities, whereas the operations folder view provides a more up-close approach to navigation. This browser analogy is furthered by the Browse Back, Browse Forward and Browse Up buttons.

Clicking on the icons within the operations folder view will navigate further down the operations hierarchy. If an operation is clicked, you will be presented with either the color picker (detailed above) if the operation requires a color or a preview image of the operation in question.

### 7.3.3 Operation Preview and Find Tool

**Operation preview**

When an operation has been selected in either the operations folder view or operations tree view, you will be shown a preview image that visually describes the effect of the operation.
If an operation is selected that makes use of a color, the color picker will be shown instead of a preview.

**The operation finder tool**

Studio Visualizer provides a large number of operations to choose from. Often you'll know which operation you want before you start browsing the operations hierarchy. In this case, it may be worth using the operation finder tool.

By typing a word or phrase in to the operation finder field and then repeatedly clicking on the Find button, the operation selector will cycle through all the operations that match the text you entered.

For example, if the word "silver" is entered in to the text-box, successive clicks of the Find button might take you to the "silver foil" operation and then the "silver metallic ink" operation and so on. The text-matching performed by the finder tool is case insensitive.

*Tip:* The operation finder tool recognizes the asterisk character *, as a wild-card. This means that it may be used anywhere in the text entered in the finder tool's text-box in order to match an arbitrary, un-specified string of characters. Although not visible in the text-box, the finder tool acts as if asterisks exist at both the beginning and end of the search-string entered.

### 7.3.4 User Operations Explained

You can now create a set of customized **user operations**. These are stored in a category called **user operations** that appears at the top of the list in the **Operation Selector** dialog.

**Why save user operations?**

The most common reasons to save user operations are:

- to collect your most frequently user operations and save them for future reuse. You save time setting up the operation details, and you no longer have to browse through the Operations list to find a specific operation.
- to save an operation with the same name as a separation in PDF files that you import. If you create user operations with the same names as the separations that are present in the PDF files you start from in Studio Visualizer, you can save a lot of time when creating new models.
- to lock certain parameters from user changes. When saving a user operation, you can lock its color or parameter settings, so they cannot be modified when you apply them afterwards.

**The user operations category**

The user operations category in the Operations list displays all your previously saved operations.
7.3.5 Create a User Operation

1. Open the Operation Selector dialog:
   - double-click an existing operation in the Operation Stack; or
   - click Insert Operation in the Actions panel to insert a new operation into the stack.

2. In the Operations list, select the operation you want to save.
   For example, select the colored foil block (hot stamped) operation in the foils folder of the Operations list.
3. Edit any parameters or colors you want to reuse later.
4. Click Save as user operation.
   The Save As User Operation dialog appears.

5. Type the Name of your customized operation, and provide a clear Description.
6. If you want to lock the operation's settings, disable the options Allow color changes and Allow changes to [setting name].
   Locking the user operation ensures that you will always use the same, approved parameter settings for this specific operation.
7. Click Save.

7.4 The Substrate Selector in Detail

A substrate within a Studio Visualizer document represents the material on which the design will be printed. The substrate appears at the bottom of the Operation Stack.

Note: The same substrate is shared by the back and front print stacks.

Initially, the substrate used in your Studio Visualizer document is either:

- inherited from a structural design file; or
- a "default paper" substrate which is based on a gloss coated paper (if there is no structural design file available).

Substrates can be selected or modified in the Substrate Selector dialog.

The Substrate Selector is identical to the Operation Selector (see The Operation Selector in Detail), with one major difference: it will only list materials/operations that can be used as a substrate.

Components of the Substrate Selector
For details on the different components, please refer to *The Operation Selector in Detail*.

### 7.5 The Artwork Selector in Detail

#### Why an Artwork Selector?

The Artwork Selector allows you to load and organize image assets for your Studio Visualizer models. Using the Artwork Selector, it is easy to:

- Keep all relevant artwork at arm’s length for easy access;
- Combine different pieces of artwork into a final image to be used in conjunction with an operation, chosen from the Operation Selector;
- Perform simple image processing tasks and apply transformations to composed images before they are used

The Artwork Selector can recognize a variety of widely used image formats including Photoshop PSD, PDF, TIFF, JPEG, PNG, BMP and GIF. On Mac OS X, PostScript and EPS files are also supported.

#### Components of the Artwork Selector
The Artwork Selector dialog is divided into three columns:

- The left-most column, labeled Image Files, lists all the files that have been loaded for use in the current Studio Visualizer model. Some files (such as PDF files) may contain more than one image, perhaps in the form of multiple layers, pages or separations.
- When an artwork file is selected in the Image Files column, the middle column, labeled Image Contents lists all the images that are contained within that file. You can select one or more images you want to combine and apply to your model by checking their corresponding boxes.
- Any checked images will appear in the list in the right-most column, which is labeled Selected Images. The image that is highlighted inside the Selected Images column may also be removed by clicking on the Remove Selected button below. Selecting more than one image will result in the images being combined by laying them over one another, starting at the bottom of the list. It is even possible to combine images from more than one image file.
A preview of the result is presented in the Result area situated in the bottom right hand corner of the Artwork Selector. To change the order in which the images are listed in the Selected Images column, simply drag-and-drop them into position.

By default, images that are lower down in the Selected Images list won’t be seen through images higher up in the list unless the higher images have transparent areas. However, this behavior can be changed.

### 7.5.1 Load and Manage Artwork

Unless you’re using Studio Visualizer’s powerful Auto-build feature, the only way to import images for use in your models is through the Artwork Selector.

1. In the Artwork Selector dialog, click the Add button at the bottom of the Image Files area.
   The file browser dialog appears.
2. Browse to and select the artwork file(s) you want to use, then click Open.
   The file (or selection of files) is added to the Image Files area of the Artwork Selector.
3. If you want to make any changes to the files in the Image Files area:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then you should...</th>
</tr>
</thead>
<tbody>
<tr>
<td>delete a file from the Artwork Selector,</td>
<td>select the file and click the Remove button.</td>
</tr>
<tr>
<td></td>
<td>Note: You cannot remove artwork that is in use by one or more operations.</td>
</tr>
<tr>
<td>replace a file with new artwork,</td>
<td>select the file and click the Replace button.</td>
</tr>
<tr>
<td></td>
<td>Note: This feature should be used with care as it will result in all references to the original file being changed to refer to the new file. It is therefore important that the layers or pages in the new file match up with the layers or pages in the original.</td>
</tr>
<tr>
<td>set the size of your model’s geometry to the dimensions of the artwork in the image file,</td>
<td>select the image file and click Set Size.</td>
</tr>
</tbody>
</table>

### 7.5.2 Transformations and Filters for Artwork

**Why apply transforms and filters?**

It may be the case that the images you load into the Artwork Selector may not be quite ready to use in one way or another. The Artwork Selector has a number of tools that you may use to change the size, orientation and positioning of your artwork, as well as some basic image processing functions.

Clicking on the Image options button in the right-hand column of the Artwork Selector will show the Image Options dialog.
Note: The image options in this window relate to the image that was highlighted in the Selected Images column when the Image options button was clicked.

### Image Options in detail

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orientation</td>
<td>Allows you to rotate the image and flip horizontally or vertically (or both!). Note when using a non-zero rotation</td>
</tr>
<tr>
<td>Area</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Image effects</strong></td>
<td>as well as a flip of some kind, the rotation is performed after the flip. If you’re unsure, check with the Preview thumbnail image located in the bottom right area of the window.</td>
</tr>
<tr>
<td></td>
<td>Provides some basic image processing functionality.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Invert colors</strong> option allows you to make the light colors dark and the dark colors light, as you would expect.</td>
</tr>
<tr>
<td></td>
<td>If the <strong>Histogram stretch</strong> option is checked, the colors used will be stretched so that the darkest color of the image is black and the lightest color is white.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Threshold</strong> options convert a continuous tone image to a black and white image.</td>
</tr>
<tr>
<td><strong>Compositing options</strong></td>
<td>Allows you to change the way that multiple images are combined to form the final image.</td>
</tr>
<tr>
<td></td>
<td><strong>Alpha composite</strong> means that the current image will be added on top of any underlying images using the image’s alpha channel to specify which areas are transparent.</td>
</tr>
<tr>
<td></td>
<td>On the other hand, <strong>Print composite</strong> treats the white areas of the image as transparent - this is useful if you have artwork which does not have an alpha channel.</td>
</tr>
<tr>
<td></td>
<td>If the image in question is actually a process color separation (i.e. a grayscale mask for one of the standard process inks: cyan, magenta, yellow or black) then you can use the <strong>Treat as separation</strong> option to apply the correct ink color.</td>
</tr>
<tr>
<td><strong>Position and size</strong></td>
<td>Allows you to position where on the model the image will be placed. The default setting is to have the image centered on the face.</td>
</tr>
<tr>
<td></td>
<td>To change this, make sure that the <strong>Center Image</strong> option is disabled. Then you may changed the fields <strong>Top</strong> and <strong>Left</strong>. The values in these fields represent the distances that the image would be placed from the origin.</td>
</tr>
</tbody>
</table>
### Area Description

is moved down from the top edge of the model's current face and in from its left-hand edge, respectively.

The **Width** and **Height** text-entry boxes allow you to scale the image in both horizontal and vertical directions. The list to the right of these entry boxes lets you choose whether their values represent millimeter dimensions, or a percentage increase or decrease from the original image size.

When the **Constrain proportions** option is enabled, the aspect ratio of the image is maintained. This means that changing the value in the **Width** field will result in the value of the **Height** field changing too.

When the **Stretch to fit** option is checked, all the other controls in the **Position and size** area are ignored. Instead, the image is scaled in each direction so that it fits within the current face of the model.

The **Set paper to match** button does the opposite of the Stretch to fit option, in that the actual model geometry will be changed such that the current face fits the image.

---

### 7.6 Editing non-printable materials

When opening a Collada file, you can select the printable area to work on. This printable area can be modified using the regular tools (Operation Stack, etc).

Other parts of the object will consist of non-printable material, like the glass of a wine bottle, the plastic lid on a detergent bottle, etc. These non-printable materials can be edited using the **Material Editor**

**Note:**

If you save / export the model after changing materials, the changes will be preserved in the saved / exported file.

1. Open the Material Editor by choosing **Model > Materials**
The Materials dialog lists all the non-printable materials in the current model. These might be things like the glass of a bottle, the plastic lid, or foil wrapper, imported from the Collada file.

2. Select the material you want to edit

You can also modify the name of the material, to give it a more descriptive or accurate name.

3. Set the Main Color. This is the base color of the material.

4. Set the Transparency of the material.

If the slider is set to the left, the material is completely opaque, if it is set to the right the material is fully transparent. In between will result in semi-transparent material.

**Note:**
- Even fully transparent objects are usually visible - a fully transparent red material for example will behave like a red gel filter, only letting through the red light.
- A fully transparent object with a white base color (like glass) will only show highlights
- A fully transparent black object will still appear opaque, since it filters all incoming light.

5. Set the Highlights Color to set the color of the reflections.

Plastic like materials usually have white reflections, Metallic materials typically have reflections similar to the base color.

6. Set the Highlights Intensity to set the brightness of the reflections. If the slider is fully to the left, there will be no specular reflections. If it is fully to the right, the reflections will be bright.

7. Set the Highlights Sharpness to control the spread of the reflection, or the haziness of the material.

Matt objects have a very low highlight sharpness (slider to the left), while glossy or shiny objects have a very high highlight sharpness (slider to the right).
Changes made in the Material Editor are shown in real time. Moving the sliders will have an immediate effect on the visual display.

If you don’t want to keep the changes you have made, you can undo using the standard undo mechanism.

7.7 Shapes

Shapes is an online library of 3D packaging shapes. From within Studio Designer, Studio Visualiser, ..., users can access the store and acquire technically correct, 3D enabled structures of popular packaging shapes. Shapes offers total flexibility, even when no CAD structures are available and complements the most versatile 3D solution dedicated to packaging and labels. It even helps generate new business opportunities as users can sell their CAD designs on the Shapes platform.

To acquire a 3D model from Shapes, you can use 2 options:

- **File > Open from Shapes** to open the 3D model in a new file (cfr. the "Open" function)
- **File > Import from Shapes** to import the 3D model in the open file (cfr. the "Import into" function).

This will open the Shapes window, in which you can choose a Shape to purchase, which will then be automatically loaded in Visualiser.
8. Customising the View with Presets

If you find a certain camera and model orientation that you find visually pleasing, or if you find that you keep positioning your models in a particular way for use in a pack-shot, then you might consider using the View Presets system.

A view preset is an item that you can save and restore which remembers the following details about a Studio Visualizer model:

- The environment and backdrop used
- The model and camera orientation
- The camera's angular field of view
- The size of the view window, and whether it is maximized.

When a view preset is applied, any or all of the above attributes will be applied to your view window (you may choose which).

8.1 The View Presets Dialog

**Local and global presets**

To show the view presets click View > View Presets... or press the F5 key.
The two lists of presets, Local presets and Global presets list all the presets that you have saved. When you save a preset, you are given the choice of whether you want to save it as a local or global preset.

Local presets are saved inside a particular Studio Visualizer model and they will only show up inside the Local presets box when that particular model is open.

Global presets are saved so that they may be used with any of your models.

You can drag presets between the local and global sections as you wish.
8.2 Create a View Preset

**Tip:** The View Presets window is a floating window which means that you may leave it open and still interact with the rest of the Studio Visualizer interface. This means that you can make changes to the view to save in a series of presets without showing and hiding the View Presets window every time.

**Tip:** When saving a preset inside a model, it won’t get written to the Studio Visualizer file until you save the model.

**Tip:** When saving a view preset that contains a backdrop image, a copy of the image is saved with the preset. Saving a model that uses a preset with an image backdrop will increase the size of that model file on disk.

1. Make sure your view is set exactly the way you want to save it.
2. Click View > View Presets... or press the F5 key.
3. Click Save... in the View Presets dialog.

The Save Preset dialog appears.

4. Type a name for the model and do one of the following:
   - To save the preset as a local preset, choose Save preset with the model;
   - To save the preset as a global preset, choose Save preset for global access.
5. Click OK.
8.3 Restore the View with a Preset

You will notice that highlighting a view preset in either list will show a small preview in the box in the bottom left corner of the View Presets window. This will give you a rough idea of what will happen when you restore a preset, though the artwork and size of the model shown in the preview image may differ to that used of your current work.

Tip: You can also click View > Apply Last View Preset or press F6 on the keyboard to restore the last preset that you saved or restored.

1. Click View > View Presets... or press the F5 key.
2. Select the preset you want to apply.
3. Do one of the following:

<table>
<thead>
<tr>
<th>If you want to apply</th>
<th>Then you should...</th>
</tr>
</thead>
<tbody>
<tr>
<td>all the saved view settings from the preset,</td>
<td>click Apply.</td>
</tr>
<tr>
<td>only a selection of the saved settings,</td>
<td>click Options... to display the View preset options.</td>
</tr>
<tr>
<td></td>
<td>Next, disable the view settings that you do not want to restore and click OK.</td>
</tr>
<tr>
<td></td>
<td>Finally, click Apply.</td>
</tr>
</tbody>
</table>

8.4 Delete a View Preset

1. Click View > View Presets... or press the F5 key.
2. Select the preset you want to delete.
3. Click Delete.